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Que és?

Es una aplicación web y de escritorio, totalmente gratuita.
Permite gestionar y compartir referencias bibliográficas, o
documentos de investigación, además de encontrar nuevos datos
y colaborar en línea.

(Ruiz, 2020)

?



Acceso y registro

Pasos

● Primero, accedemos a la
página web:
http://www.mendeley.com.

● Después, creamos una cuenta
con el enlace “create a new
account”. Se debe llenar el
formulario correspondiente.

● Una vez creada la cuenta, se
puede descargar la aplicación
para instalarla en nuestro
ordenador, desde el enlace
“Download Mendeley Desktop”.

De esta forma tendremos

disponibles la versión local

y la versión web.

● Por último, elegimos la
versión correspondiente a
nuestro sistema operativo.
El programa se instala en el
ordenador siguiendo las
instrucciones.

(Rodríguez, 2011)

http://www.mendeley.com


Etiquetas: Lista todas las 
etiquetas que hayamos usado 

para clasificar las 
referencias bibliográficas.

Versión web

Barra de herramientas:
Podemos añadir 

documentos; borrar 
documentos o 

referencias; crear y 
gestionar las carpetas 
para organizar las 

referencias; crear un 
grupo; instalar el 

botón “Web Importer”; 
y ver el estado de 
nuestra cuenta.

Referencias 
bibliográficas:
Muestra todas las 

referencias contenidas 
en nuestra biblioteca.

Gestión de carpetas y 
Grupos: En función de 
la carpeta o grupo 

que seleccionemos, se 
presentarán las 
referencias 

bibliográficas que 
hayamos incluido.

Filtro de 
publicaciones, 

autores, etiquetas y 
palabras clave: Nos 
ayuda a seleccionar 
todas las referencias 

y documentos que 
hayamos clasificado 
bajo una determinada 

etiqueta.

(Rodríguez, 2011)



Aquí podemos 
configurar y 

administrar las 
distintas 

colecciones de 
documentos.

Versión local

Se muestran todos 
los documentos. 
Existen dos tipos 
de visualización: 
formato tabla y de 

cita.

Se visualizan los 
detalles del 
documento 

seleccionado, 
también se pueden 
agregar etiquetas y 

notas.

En esta sección 
podemos aplicar 
filtros por 

autor, palabras 
claves, 

publicaciones, o 
etiquetas 
personales. (Rodríguez, 2011)



● Extrae automáticamente los
metadatos y las referencias de
los archivos PDF.

● Permite realizar búsquedas en los
textos completos.

● En los archivos PDF, dispone de
un visor propio en el que podemos
subrayar el documento, y hacer
anotaciones para compartir con
otras personas.

● Permite sincronizar la base de
datos bibliográfica a través de
varios ordenadores, además de
compartir con otras personas, o
integrar las referencias en blogs
y sitios web.

Características
● Permite la integración con editores

de texto, como Microsoft Word.
● Captura referencias bibliográficas

de sitios web, usando la herramienta
“Web Importer” o sincronizándose con
Citeulike y Zotero.

● Crea grupos para compartir
documentos y etiquetas.

● Visualiza estadísticas de los
documentos, autores y publicaciones.

● Permite crear un perfil profesional
de investigador, para compartir las
publicaciones, premios y
conferencias.

(Rodríguez, 2011)



Añadir referencias

Para añadir documentos a 
nuestra base de datos de 
Mendeley, tenemos varias 
opciones que dependen si 

usamos la interfaz web o el 
programa de escritorio.

(Ruiz, 2020)



Esta opción también se

encuentra disponible desde la

barra de herramientas en el

desplegable “Add Documents”.

● Desde el menú principal
pulsamos en “File” y elegimos
“Add entry manually”.

● Nos aparecerá un formulario
para que escribamos los datos
del nuevo documento.

Manualmente Pasos

(Rodríguez, 2011)



Archivos PDF

Dos formas

● Elegimos el botón “Add
Document” en la barra de
herramientas, o podemos
arrastrar los PDFs al panel de
contenido.

La opción “Watch a folder” nos
permite incorporar PDFs
automáticamente desde varias
carpetas a la vez.

(Rodríguez, 2011)



Otros gestores 
bibliográficos

Ejemplo: EndNote

● En la página EndNote, exportamos
la biblioteca escogiendo .xml
como tipo de fichero, y RIS como
estilo de salida, le damos un
nombre y lo guardamos.

● En Mendeley, damos clic en “Add
Files”, seleccionamos el fichero
XML que habíamos exportado
previamente de EndNote, y
pulsamos en “Open”. Así, se
incorporará la biblioteca de
EndNote a Mendeley.

Usaremos la opción “Add Files” 
para importar referencias de 

BibText y RIS.

(Rodríguez, 2011)



Bases de datos
Ejemplo: Embase

● Realizamos la búsqueda en EMBASE,
y seleccionamos las referencias
que nos interesa.

● Damos clic en “Exportar”, y se
abrirá un cuadro de diálogo en el
que podemos elegir el formato de
exportación.

● Elegimos “RIS”, y guardamos el
fichero.

● Desde Mendeley lo importamos
utilizando la opción “Add
Documents” y “Add Files”.

Ejemplo: Mergullador

● Realizamos la búsqueda en
Mergullador, y guardamos los
resultados en “Mi espacio”.

● En “Mi espacio”, marcamos los
registros que nos interese
importar dando clic en “registros
seleccionados” y “guardar”.

● Elegimos “Gestor de citas” y lo
codificamos como “UTF-8”.

● En Mendeley procedemos desde “Add
Documents” y “Add Files”.

(Rodríguez, 2011)



Otros sitios web

Mendeley permite la importación
directa de referencias, desde los
siguientes sitios web:

● ACM Portal
● Amazon
● arXiv
● CiNii
● Copac
● GBV
● IACR ePrints
● Ingenta Connect
● Informaworld
● ScienceDirect
● Refdoc
● OpticsInfoBase
● PNAS
● RePEc
● ScienceMag
● ACS Publications
● APS

● BioMedCentral
● CiteseerX
● DBLP
● GoogleBookSearch
● IEEE Xplore
● INIST/CNRS
● JSTOR
● NASA ADS
● OvidSP
● PubMed
● SAGE
● AIP Scitation
● APA PsycNET
● BioOne
● CiteUlike
● EBSCO
● Google Scholar

(Rodríguez,

2011)



Sincronizar  
(Synchronize Library)

Esta característica nos permitirá
acceder a nuestros PDFs desde
cualquier parte.

El proceso de sincronización puede
ser de web a local y de local a
web, de forma que podemos enviar
los pdfs guardados en el ordenador
a nuestra cuenta web de Mendeley.
Cabe destacar que permite
almacenar hasta 500MB.

● Seleccionamos “All Documents”
● Damos clic en “Edit Settings” y

seleccionamos las colecciones que
queremos sincronizar.

● Pulsamos en “Sync Library” para
sincronizar las cuentas de la
versión local y web. (Si no se
encuentra abierta, nos pedirá
ingresar).

Pasos

(Rodríguez, 2011)



Exportar desde 
Google académico

● Tras realizar una búsqueda
en Google Académico,
hacemos clic en (Citar).

● Se abrirán las opciones
para citar y seleccionamos
“RefMan”.

● Se descarga un fichero Ris,
que tendremos que añadir a
nuestra base de datos en
Mendeley.

(Ruiz, 2020)



Cuentas de otros 

usuarios

Es posible añadir referencias 
desde cuentas de otros 
usuarios de Mendeley.

● Haremos una búsqueda en la web
de Mendeley sobre el tema de
nuestro interés.

● Del listado de resultados
obtenidos, añadimos a nuestra
biblioteca aquellos que nos
interesen, dando clic en “save
references to library”.

Pasos

(Rodríguez, 2011)



Exportar referencias

● Seleccionaremos los documentos
que queremos exportar.

● Damos clic en “File Export”, o
presionando Ctrl + E.

● Se abrirá un cuadro de diálogo en
el que podremos elegir el formato
en el que queremos guardar el
fichero: .xml, .ris o BibTex.

Pasos

(Rodríguez, 2011)



Trabajar con 

documentos y 

referencias



Cuando se añaden las
referencias aparecen marcadas
como “no leídas” con un
círculo verde. Una vez que se
abren, el círculo verde
desaparece y quedan marcadas
como “leídas”. Podemos
marcarlas y desmarcarlas como
no leídas tantas veces como
deseemos.

Leídos / no leídos  

(Rodríguez, 2011)



Las referencias y documentos
favoritos, se marcan con el
icono de una estrella a la
izquierda de la referencia.
Se marcan simplemente dando
clic sobre la estrella para
marcarlos como favoritos, o
repitiendo el clic para
desmarcarlos. Además, todos
los marcados como favoritos
aparecen en la carpeta
“Favorites” del panel “My
Library”.

Favoritos

(Rodríguez, 2011)



Organizar y gestionar 
referencias / carpetas

Ordenar 
referencias

En el panel de contenido, hacemos
clic en el criterio que queremos
ordenar: favoritos, leído/no
leído, documentos con pdf
adjunto, autor, título, año,
revista, y fecha de incorporación
a la base de datos.

Mendeley permite organizar toda la información de nuestras
búsquedas, además de eliminar las referencias duplicadas, o de
organizarlas mediante carpetas y subcarpetas. También, es útil
asignar etiquetas (tags) a cada documento para poder establecer
diferentes filtros.

Se utilizan para organizar
nuestras referencias. Las
podemos crear y borrar
desde la opción “Folder”
de la barra del menú.

Crear 
carpetas

(Rodríguez, 2011)



Depurar nombres de 

autor, etiquetas o 

duplicados

En el panel de filtro por
autor/etiquetas y publicaciones,
(Filter by authors/tags/publications);
seleccionamos el nombre que está
duplicado o es incorrecto, y
arrastramos sobre la forma correcta
para renombrarlo.

(Rodríguez, 2011)



Etiquetar y editar 
varios documentos 

a la vez
● Seleccionamos los documentos que

queremos editar a la vez,
pulsando la tecla Control.

● En el panel de detalles del
documento, aparecerá un mensaje
de confirmación.

● Finalmente, añadiremos los datos
que queremos incorporar a todos
los documentos.

Los datos pueden ser etiquetas,
notas u otros detalles
bibliográficos, como el nombre
de la revista o publicación.

Pasos

(Rodríguez, 2011)



Buscar

Mendeley contiene un
buscador que permite
encontrar aquellos
documentos que contengan
un determinado término.
Puede buscar en los campos
de autor, título, nombre
de la publicación, año y
notas. También, se puede
realizar la búsqueda
dentro del pdf con el
texto completo del
documento.

Realizar anotaciones 

en los pdfs

Mendeley dispone de un visor de
PDFs en la versión local, que
permite añadir subrayados y
anotaciones a los documentos. Para
ello:
● Abrimos un PDF en el visor de

Mendeley, haciendo doble clic
en el panel central.

● Añadiremos subrayados haciendo
clic en “Highlight Text” o
añadiremos notas pulsando el
botón “Add Note” del menú de
la barra de herramientas.

(Rodríguez, 2011)



Eliminar duplicados

Cuando añadimos información a
Mendeley desde diferentes fuentes,
puede darse el caso de que las
referencias importadas estén
duplicadas.

● Seleccionamos la carpeta o
grupo, en los que queremos
buscar duplicados.

● Seleccionar “Tools” en el menú
principal, y dar clic en la
opción “Check for Duplicates”.

● Se mostrarán los grupos de
duplicados. (Haciendo doble clic
se puede ver cada referencia
duplicada individualmente).

Pasos

(Rodríguez, 2011)



● Seleccionamos un grupo y
revisamos los metadatos en el
panel de la derecha. Cuando a
la izquierda de cada campo
aparece una marca, esto quiere
decir que contiene la misma
información en todas las
referencias.

● Hacemos clic en el botón
“Confirm Merge” para unir todas
las referencias del grupo en
una.

Si se descubren dos documentos
que están en un grupo de
duplicados pero que no lo son,
simplemente, se selecciona el
documento marcado erróneamente
como duplicado, y se hace clic en
el botón “Not a Duplicate”. (Esto
a menudo es necesario cuando hay
muchos registros sin título).

Unir duplicados Duplicados incorrectos

(Rodríguez, 2011)



Si se observa que hay duplicados
que, por alguna razón Mendeley no
encuentra, se pueden unir los
documentos manualmente.

● Seleccionamos dos o más
documentos mientras se
mantiene pulsada la tecla
Control.

● Damos clic en el botón “Merge
Documents” en el panel
derecho, y se siguen los pasos
normalmente.

Cualquier unión que hagamos con la
herramienta de buscar duplicados, se
puede deshacer usando la opción
“Edit>Undo” del menú principal.
Cuando se unen duplicados, todos los
documentos van a la carpeta “Trash”,
y se crea un nuevo documento, así
que se pueden restaurar los
documentos originales desde ahí e
intentar unirlos de nuevo.

Unión manual de 
duplicados

Qué pasa si nos 
equivocamos?

Pasos

(Rodríguez, 2011)
?



Organizar ficheros

Permite renombrar automáticamente 
nuestros PDFs, y archivarlos en 

unas carpetas que permiten 
encontrar fácilmente los ficheros.

En la pestaña “File Organizer”
podemos seleccionar:

● “Organize my files”: permite
hacer una copia de todos los
documentos añadidos a Mendeley
en una carpeta.

● “Sort files into subfolders”:
permite crear una estructura
de carpetas basada en detalles
de los documentos
seleccionados.

● “Rename document files”: para
renombrar de forma que incluya
autor, revista, año y título.

(Rodríguez, 2011)



Citas y bibliografía

Mendeley generá bibliografías y listas de referencias en
1.000 estilos de citación distintos. Es compatible con los
principales editores de texto, entre ellos: Word, OpenOffice,
Google Docs y LaTex.

Estilos de cita

Para seleccionar el estilo de cita que queremos, debemos:
● Pulsar “View>Citation Style” del menú principal.
● Seleccionar el estilo que necesitamos usar.
● En caso de que el estilo no esté en el listado, debemos

hacer clic en “More Styles” y buscar el que necesitemos,
e instalarlo de forma que quedará incorporado en nuestra
lista.

(Rodríguez, 2011)



Para generar bibliografías, insertar y dar formato a un
manuscrito, debemos tener instalados los plug-ins disponibles
para Word y OpenOffice. Esta instalación se realiza de la
siguiente manera: Hacemos clic en “Tools” del menú principal, y
debemos seleccionar la instalación que necesitemos: Install MS
Word Pluging o Install OpenOffice. Una vez realizada la
instalación, se incorporará a la barra de herramientas de Word en
la opción “Complementos”.

Generar bibliografías, insertar citas y 

formatear un manuscrito

(Rodríguez, 2011)



● Para un manuscrito, podemos hacer clic en “Insert
Citation” en la barra de herramientas de Mendeley en Word.
O Desde Mendeley Desktop, seleccionamos el documento y
pinchamos en “Send Citation to Word”.

● Para el estilo de cita que deseemos utilizar en Word,
accedemos al desplegable “citation style”. Cada vez que
elijamos un estilo diferente, deberemos hacer clic en
“Refresh” y aplicar los cambios de estilo.

● Para generar una bibliografía, hacemos clic en “Insert
Bibliography”, o Mendeley nos ofrece la posibilidad de
exportar el documento desde el botón “Export”.

● Para citar documentos en Google docs (y otros editores de
texto), seleccionamos en Mendeley Desktop el documento que
queremos citar y hacemos clic en: “Edit Copy citation”.
Después pegamos el documento, o también se puede arrastrar
y soltar desde Mendeley a la ventana donde estemos
trabajando.

(Rodríguez, 2011)



Crear y gestionar grupos

Son una forma sencilla de colaborar con
otras personas, mediante la creación de una
colección de documentos compartidos.
Cualquier usuario de Mendeley puede crear
un grupo con colaboradores o con
investigadores desconocidos. Asimismo,
cualquier miembro del grupo puede subir
documentos al mismo.

Para crear un grupo demos hacer clic en
“Create Group” en el panel izquierdo, o
usando la opción “Edit > New Group” del
menú principal.

Grupos

(Rodríguez, 2011)



● Group name: Especificaremos el nombre del grupo.
● Group description: Podremos dar más detalles sobre el grupo con

una breve descripción.
● Privacy settings: Esta sección nos permite establecer el tipo de

grupo que vamos a crear.

● Give this group more details: Nos permite añadir etiquetas o
indicar la disciplina en la que investigamos.

● Para borrar un grupo, lo seleccionamos y hacemos clic en “Edit>
Remove group” del menú principal.

● Siempre podremos cambiar estos criterios seleccionando el grupo
que hemos creado y haciendo clic en “Edit settings”.

Términos importantes en los grupos

(Rodríguez, 2011)



● Grupos privados (private groups): Son grupos a los que se
puede pertenecer sólo por invitación y cuyo contenido sólo
será visible para los miembros del grupo.

● Grupos públicos con invitación (Anyone can ask to join this
group): Son grupos visibles para cualquiera, pero en los que
sólo pueden contribuir los miembros del grupo.

● Grupos públicos abiertos (Anyone can join this group): Son
los grupos a los que cualquiera puede unirse y contribuir en
ellos.

Tres tipos de grupos

(Ruiz, 2020)



Añadir miembros y documentos

Una vez creado el grupo podemos añadir los miembros y documentos:

● Members: Invitamos a más personas. Si son ya contactos nuestros
en Mendeley, hacemos clic en “Add”, o también, se pueden invitar
por e-mail para unirse al grupo por medio de “Invite”.

● Documents: Para ver los documentos de un grupo. Si queremos
añadir documentos, seleccionamos el grupo y seleccionamos “Add
documents” en la barra de herramientas.

● Edit Settings: Para descargar los PDFs que incorporaron al grupo
otros miembros. Se debe marcar “Download attached files from
group” en “File synchronization”.

● Sync Library: Podremos subir a Mendeley Web todas las
características que hayamos dado a los grupos.

● Overview: Tenemos acceso a un resumen de lo que pasa en el
grupo.

(Rodríguez, 2011)
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